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Parallels Desktop 13 for Mac Update 3 Hotfix 2 (13.3.2-43368)

This update for Parallels Desktop 13 for Mac 13.3.2 (43368) addresses overall stability and performance issues, and
includes the following fixes and improvements:

Resolves an issue with the mouse pointer getting stuck in macOS virtual machines.• 
Resolves an issue with Mac applications having black icons in Windows.• 
Resolves an issue with the Practice Perfect app leaving graphical artifacts after working in Coherence.• 
Resolves an issue with macOS 10.14 Developer Beta virtual machines showing a black screen after the
Parallels Tools installation. If you have such a virtual machine, do the following:

• 

1. Install this update.1. 
2. The virtual machine window may continue showing a black screen. If so, check the virtual machine’s
live preview in Control Center - if you see the login screen, click the black window where the password
field should be located and enter your password to log in.

2. 

3. Then wait until the Parallels Tools are updated automatically and the virtual machine is restarted. This
may take a few minutes. After that, the virtual machine window should display macOS again.

3. 

Known issues:

When a macOS virtual machine goes to sleep, the guest version of macOS is paused. Then, after you
resume it, the mouse pointer is not displayed. To work around this issue, resize the virtual machine
window.

• 

Parallels Desktop 13 for Mac Update 3 Hotfix 1 (13.3.1-43365)

This update for Parallels Desktop 13 for Mac 13.3.1 (43365) addresses overall stability and performance issues, and
includes the following fixes and improvements:

General enhancements

Attach screenshots and other files to technical data reports.• 
Resolves an issue with sound not playing in virtual machines after closing and then opening the MacBook’s
lid.

• 

Resolves an issue with screen refresh rate becoming low when a virtual machine is started with the
“Always ready in background” option selected.

• 

Resolves an issue with Parallels Desktop Control Center appearing after launching a guest OS application
from the Dock.

• 

Windows support
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Resolves an issue with Parallels Tools not installing in a Boot Camp virtual machine with Windows 10.• 
Resolves an issue with app-related folders not visible in iCloud shared with Windows.• 
Resolves an issue when the icons of applications started from Visual Studio 2013 didn’t appear in the
Dock.

• 

Resolves an issue with MS Word 2011 for Mac saving doc/docx files to the C:\ drive only in the
Read-Only mode.

• 

Resolves an issue with not being able to add the Boot Camp partition as a second disk to a virtual machine.• 
Resolves a rare issue with Windows freezing when accessing a shared folder from the guest OS.• 
Resolves an issue with Windows 10 crashing sometimes when searching for a particular address in Google
Chrome > Google Maps.

• 

Resolves an issue with Windows crashing when starting TwinCAT 3 in Visual Studio.• 

Linux support

Support for Ubuntu 18.04.• 
Resolves an issue with Ubuntu 14.04 not starting after the Parallels Tools installation.• 
Resolves an issue with the prl_eth driver not compiling for Linux kernel 4.15.• 
Resolves an issue with Parallels Tools not installing in Kali Linux 2018.1.• 
Resolves an issue with Parallels Tools not installing in Red Hat 7.5.• 

macOS support

Resolves an issue with iTunes quitting unexpectedly in macOS 10.8 and 10.9 virtual machines.• 
Resolves an issue with Parallels Tools not installing in macOS 10.13.3 virtual machines.• 
Resolves an issue with macOS 10.13.4 virtual machines freezing on waking from sleep.• 
Resolves an issue with not being able to upgrade macOS 10.13.3 virtual machines to macOS 10.13.4.• 

Parallels Desktop 13 for Mac Update 3 (13.3.0-43321)

This update for Parallels Desktop 13 for Mac Update 3 (13.3.0-43321) addresses overall stability and performance
issues, and includes the following fixes and improvements:

Resolves an issue with ~/§±£`? symbols not typed correctly in virtual machines.• 
Resolves an issue with disproportionately scaled Windows after installing a Windows update.• 
Resolves an issue with gamma settings being changed by Windows in Full Screen.• 
Resolves an issue with unintended activation of Grayscale Mode in Windows 10 after pressing + holding
the “Command” key and then pressing “C”.

• 

Resolves the following occasional issues in Windows virtual machines:
slow login;♦ 
unresponsive Start Menu;♦ 
inability to use a keyboard with some apps.♦ 

• 

Resolves an issue with the CTC (click-to-call) technology not working when you right-click a number in
Internet Explorer and choose to call this number.

• 

Resolves an issue with Parallels Tools not working in macOS High Sierra virtual machines.• 
Resolves an issue with a virtual machine not starting after double-clicking its alias.• 
Resolves an issue with Boot Camp-based virtual machines not starting in Parallels Desktop 13.2.0.• 
Resolves a problem causing your Mac to crash after a virtual machine is bridged to Thunderbolt Bridge.• 
Resolves an issue with shared camera not working in Skype for Business.• 
Resolves an issue with graphics artifacts in Battlefield 3.• 
Resolves an issue with graphics artifacts when zooming images in Tekla Structures.• 
Resolves an issue with PaintShop Pro not opening images on your Mac and not available in the “Open
With” menu.

• 
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Resolves an issue with deferred activation when deploying Parallels Desktop Business Edition using
DeployStudio or NetRestore.

• 

Parallels Desktop 13 for Mac Update 2 (13.2.0-43213)

This update for Parallels Desktop 13 for Mac 13.2.0 (43213) addresses overall stability and performance issues, and
includes the following fixes and improvements:

Mass deployment:

Resolves an issue with mass deployment not working on macOS High Sierra on Macs where Parallels
Desktop has never been installed.

• 

Windows support:

Resolves an issue with delayed mouse response when switching to a virtual machine running in Full Screen
on a second 5K monitor.

• 

Resolves an issue with slow video playback in Microsoft Edge and “Movies & TV” app.• 
Resolves an issue with Parallels Tools updating incompletely and showing the “Windows cannot access
\Mac\Home\Desktop” message after upgrading to Parallels Desktop 13.

• 

Resolves an issue with launching Internet Explorer 11 after upgrading to Parallels Desktop 13.• 
Resolves an issue with Caps Lock not working with Windows 10 native apps when a Parallels keyboard
layout is selected.

• 

Resolves an issue with not being able to complete the installation of Windows Server 2016 Standard.• 

Integration:

Resolves an issue with the camera not working in FaceTime after Parallels Desktop has been started.• 
Resolves an issue with sound input not working in Windows after waking the Mac from sleep.• 
Resolves an issue with a virtual machine not resuming from paused state after the Mac wakes up.• 
Resolves an issue with the mouse not working in the guest version of macOS 10.13 after suspending and
resuming the virtual machine.

• 

Boot Camp support:

Resolves an issue with the “There is no operating system installed in this virtual machine” message
appearing when launching a newly created Boot Camp virtual machine.

• 

Resolves an issue with Boot Camp virtual machines not booting and stuck on “Trying to boot from SATA
drive 1”.

• 

Resolves an issue with not being able to create a Boot Vamp virtual machine on Macs with High Sierra.• 
Resolves an issue with not being able to create a Boot Camp virtual machine on 2010 or earlier Macs.• 
Resolves an issue with not being able to create a Boot Camp virtual machine on Macs with Fusion Drive.• 

Support for the English and non-English keyboard layouts:

UK and US keyboard layouts:

Resolves an issue with the §± and `~ keys mixed up in the UK English keyboard layout.• 
Resolves an issue with not being able to type the §± keys using a physical keyboard when the US -
International layout is selected.

• 

Resolves an issue with the Dvorak layout in Windows differing from that in macOS.• 

European keyboard layouts:

Resolves an issue with “>” typed instead of “§” in the Danish, Finnish, Norwegian, Swedish, Swiss
German, and Swiss French keyboard layouts.

• 



Resolves an issue with ctrl + '-' not working in the French and Dutch layouts.• 
Resolves an issue with the §± and `~ keys mixed up in the Dutch keyboard layout.• 
Resolves an issue with incorrect results for the §£ and `~ keys in the Polish Pro layout.• 

Brazilian Portuguese keyboard layout:

Resolves an issue with the §± and <> keys mixed up in the Brazilian Portuguese keyboard layout.• 
Resolves an issue with ctrl+' ` ' working instead of ctrl+'-'.• 

Arabic keyboard layout:

Resolves an issue with the § and ± symbols not typed when the Arabic layout is selected.• 
Resolves an issue with () typed instead of (?).• 

Linux support:

Resolves a network issue in the Cent OS 7 virtual appliance.• 

Parallels Desktop 13 for Mac Update 1 Hotfix 1 (13.1.1-43120)

This update for Parallels Desktop 13 for Mac 13.1.1 (43120) addresses overall stability and performance issues, and
includes the following fixes and improvements:

Resolves an issue with USB 3.0 not working in the guest version of macOS 10.13.• 
Resolves an issue with installing macOS in to a virtual machine from a USB installation drive.• 
Resolves an issue with installing macOS 10.12 Sierra in to a virtual machine.• 
Resolves an issue with the mouse and keyboard not working in the guest version of macOS
10.10/10.9/10.8/10.7.

• 

Resolves an issue with incorrect detection of macOS version when installing macOS from the Recovery
partition.

• 

Resolves an issue with graphics artifacts (look like a rainbow) sometimes appearing in the virtual machine
window.

• 

Resolves an issue with Windows 10 not booting when “Enable nested virtualization” is selected in the
virtual machine configuration and “Hyper-V” is enabled in Windows.

• 

Resolves an issue with the Parallels Desktop app icon not available in the Applications folder after
installation.

• 

Parallels Desktop for Mac 13 Hotfix 1 (13.0.1-42947)

This update for Parallels Desktop 13 for Mac 13.0.1 (42947) addresses overall stability and performance issues, and
includes the following fixes:

Resolves an issue with incorrect mapping of the Parallels Belgian keyboard after upgrading to Parallels
Desktop 13.

• 

Resolves an issue with incorrect mapping of the Parallels UK keyboard after upgrading to Parallels
Desktop 13.

• 

Resolves an issue with virtual machines not switching to Coherence view mode after upgrading to Parallels
Desktop 13 on Macs with High Sierra Beta 7.

• 



Parallels Desktop 13 for Mac release build 13.0.0 (42936)
includes the following new features:

Parallels Desktop® 13 for Mac is the simplest, most powerful solution for running Windows and Windows
applications on Mac® without rebooting. For more information, see the Parallels Desktop 13 for Mac
documentation.

Performance

Working with Windows files from macOS® is up to 20% faster if the virtual machine is on a solid-state
drive (SSD) and up to 40% faster if on a rotational hard drive (HDD).

• 

Working with Windows files from Windows is up to 50% faster if the virtual machine is on a rotational
hard drive (HDD).

• 

Working with files on a Thunderbolt™ SSD storage connected to Windows is up to 100% faster.• 
Working with files on a USB 3.0 storage connected to Windows is up to 40% faster.• 
Creating a virtual machine snapshot is up to 50% faster.• 

General Enhancements

If you don't have Windows, Parallels Desktop can help you download and install Windows 10.• 
If you want to try Parallels Desktop, the trial period begins only after you start your virtual machine for the
first time — so you have more time to work with it.

• 

During the trial period, all options available only in Parallels Desktop® for Mac Pro Edition are marked
with a special "PRO" sign, making it easier for you to choose which edition you need.

• 

Parallels Desktop shows a confirmation message when you try to stop or reset Windows while Windows is
installing updates.

• 

Parallels Desktop informs you when some actions (for example, downloading and installing virtual
appliances) become unavailable because of no Internet connection.

• 

Distinguish the virtual machines that have snapshots by the new snapshots icon, and use it to open the
snapshots manager with a single click.

• 

Work with your virtual machine in a new view mode: Picture-in-Picture:
The virtual machine is displayed in a small window that becomes transparent when you switch to
another window.

♦ 

You can choose to show the virtual machine window on all Spaces and on top of other windows.♦ 
The Close button switches the virtual machine back to the Window view mode.♦ 

• 

New context-sensitive help for all Parallels Desktop options. Just click the “?” icon and read a description
of each option on the screen.

• 

Transferring a Windows PC to a virtual machine on your Mac has been improved.• 
Converting third-party virtual machines to the Parallels format has been improved.• 
Working with a Boot Camp® virtual machine has been significantly improved.• 

Graphics

Now when you resize the virtual machine window or switch between view modes, the virtual machine
screen resolution changes faster and more smoothly.

• 

We continue working on OpenGL 3.0 support. The first results could already be seen in an update for
Parallels Desktop 12, where we added support for such games as Rage, Wolfenstein: The New Order, and
Wolfenstein: The Old Blood. Now we’ve added support for DIALux evo and Northgard.

• 

The way Windows is displayed when the Retina Resolution > Scaled option is selected has been
improved: the text became crisper and graphics sharper.

• 

Integration with Mac

Initial support for macOS 10.13 High Sierra as both the host and guest operating systems. Once this system
is officially released, you may need to update Parallels Desktop.

• 

https://www.parallels.com/products/business/support/
https://www.parallels.com/products/business/support/


Use the Touch Bar™ on your MacBook® to work with Parallels Desktop, Windows, and Windows
applications.

• 

Customize the Touch Bar for Windows applications.• 
Protect the Parallels Desktop preferences and virtual machine configuration from editing with Touch ID®.• 

Support for Windows 10 Fall Creators Update

Initial support for Windows 10 Fall Creators Update. Once this operating system is officially released, you
may need to update Parallels Desktop.

• 

Extended support for the People Bar feature:
Communicate with people from the macOS Dock, Finder®, and Spotlight®.♦ 
Pin as many persons to the Dock as you wish.♦ 
When Windows is running in Coherence, manage the People Bar from the macOS menu bar.♦ 

• 

Linux

Improved support for Zorin OS, Elementary OS, Kali Linux, and Manjaro Linux guest operating systems:
Parallels Tools can be installed and work properly.♦ 
These systems are automatically detected during the installation.♦ 
Proper icons of these OSs are used in the Parallels Desktop interface, so that users can distinguish
them from other Linux virtual machines.

♦ 

• 

Download Linux Mint virtual appliances from Installation Assistant.• 

New Design

The Parallels Desktop interface has been improved and redesigned to make it even more clear and
user-friendly.

• 

The sign-in and license-related dialogs have been redesigned to make them more clear and simple.• 
Editing the virtual machine hard disk properties has been improved and slightly redesigned. By default,
virtual hard disks now provide up to 256 GB, so you have less reasons to edit the disk properties.

• 

Change the Parallels Desktop interface color — you can choose between the light gray and dark color
schemes.

• 

The Parallels Desktop icon has been updated with Windows 10.• 

Present for Parallels Desktop Users

Download and install Parallels® Toolbox for both Mac and Windows to simplify your everyday tasks.
(Parallels Toolbox is completely free for Parallels Desktop 13 customers.)

• 

For Parallels Desktop Pro Edition and Business Edition Only

Assign up to 32 CPUs and 128 GB of RAM to a virtual machine.• 
Use a new Extended memory limit option to allocate even more memory to your virtual machine than
your Mac has. This functionality is designed for developers and testing purposes.

• 

Use Intel® VTune Amplifier, Linux “perf”, and Mozilla “rr” to improve your applications performance. To
use this feature, enable PMU virtualization on the Hardware > CPU & Memory tab of the virtual
machine configuration.

• 

Quickly change the virtual machine screen resolution from the View > Set Resolution menu. To use this
feature, enable Show developer tools on the Options > More Options tab of the virtual machine
configuration.

• 

Now you don’t have to spend time looking for your virtual machine IP address. Find and copy it from the
Devices > Network menu. To use this feature, enable Show developer tools on the Options > More
Options tab of the virtual machine configuration.

• 



For Parallels Desktop for Mac Business Edition Only

Don’t bother inexperienced users with the Parallels Desktop interface, Windows installations, and
virtualization — allow them to work with selected Windows applications in the all-new Single Application
mode. For more information, please read the Parallels Desktop Business Edition Administrator’s Guide.

• 

Improved structure of the Parallels Desktop Mass Deployment package.• 
Add selected Windows applications to the macOS Dock while deploying the Parallels Desktop Mass
Deployment package.

• 

Improved and redesigned security-related settings.• 
Use Touch ID to approve various password-protected actions on your virtual machines (for example,
changing the virtual machine state, editing the virtual machine configuration, and more).

• 
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